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Welcome to the _
HubSpot Content Hub ),
Overview Guide!

p-

This guide is your comprehensive overview of
what Content Hub, HubSpot’s latest innovation,
brings to the table—detailing its key features,
its position as a successor to CMS Hub, and its
potential as a powerful tool for website
creation. We'll also delve into its pricing
structure, how it fares against WordPress, and
whether making the switch could benefit your
digital strategy. It’s all about giving you the
information you need to make informed
decisions for your web presence.

While we celebrate Content Hub'’s
advancements, we're not shying away from
discussing its limitations. This guide aims to
provide a balanced view, highlighting the
platform's strengths and pointing out areas
awaiting improvement. Whether you're
contemplating a transition from WordPress or
simply exploring options for your website, this
guide offers valuable insights into Content
Hub’s role in the future of web management.
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Understanding
Content Hub

What does CMS mean?

If you're not familiar with the ‘cms’ acronym, you
may have been confused about what HubSpot’s
CMS Hub was all about.

CMS is an industry term for ‘content management
system’. Which itself might be confusing...

When HubSpot referred to CMS Hub they were
primarily talking about building websites. So if you
just thought CMS = Websites, then you were pretty
much on the money. Of course if you're familiar with
the whole CMS industry, then you'll know it is much
more than that. But for our purposes, consider it
being about websites.

What is HubSpot Content Hub?

At its simplest, Content Hub is a repackaging of
HubSpot's CMS Hub plus a few Marketing Hub tools.

Whilst existing customers who have CMS Hub can
keep it, new customers won't see CMS Hub as an
option to purchase. Instead, they’ll see Content Hub.

Content Hub is HubSpot's way of:

¢ Avoiding the confusion of ‘CMS’ in the naming -
which most people didn’t understand

* Making it clear that HubSpot has a compelling,
fully-featured website offering

¢ Signalling that HubSpot is extending beyond just
websites when it comes to ‘managing content’,
and will be the place where you can store all
your business marketing and sales assets (files,
pages, posts, images, videos, podcasts, etc).

In the following pages, we're going to cover a ton of
the features of Content Hub.

But consider this an initial version - we’ll be updating
this and expanding on areas over the coming
months.
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HubSpot Content

Hub Overview

Content Hub versus CMS Hub

As mentioned above, in many ways Content Hub is
just a repackaging of CMS Hub.

At initial release, you won't notice too many
differences to what you already have in CMS Hub.

But this is just the start.

Whilst there are only a few new features in Content
Hub (eg content remixing) that aren’t in CMS Hub,
you can expect this to change. As new content-
related tools and functionality are released, they'll
most likely only be available in Content Hub (ie you
won't receive them in CMS Hub).

Isit just Websites, or more than that?

Most of our focus will be on building websites on
HubSpot. That's what we feel is the main use case
for Content Hub currently.

But along the way, we’ll touch on additional use
cases.

There’s so much to cover, for now, we'll focus on
website scenarios.

Which Tier of HubSpot Content Hub
has these features?

In this guide, we won't be indicating which tier
(Starter, Pro, Enterprise) is required for each
feature/tool. This is because the tier and Hub
assignment is changing. We've touched on some
general differences at the end of the guide, andin a
future version we'll provide more specific clarity on
the tiers required.

Many of the tools are available in Starter, but the
more sophisticated tools will require Pro or
Enterprise (eg Approvals is currently an Enterprise
tier feature).
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Core CMS Functionality

in Content Hub

In this section we're going to cover the foundational
features that all website CMS tools need to have
(and Content Hub is no exception).

These are the basics that any website tool needs.

Themes and Templates and Modules

HubSpot has a mature Theme and Template
Marketplace now. It has been incrementally
improving this over the last 4 or so years.

A few years ago we used to custom develop the
Templates we built websites with. But in the last 2
years we've moved to exclusively using a
marketplace theme.

We've found that the flexibility that good Themes
provide is more than enough for most website builds
these days.

You can sort by popularity on the marketplace to
see reviews etc.

Or, if you're after a few specific Theme
recommendations, here’'s what we use:
* At XEN Create we use CLEAN theme (usually
Pro, but sometimes Lite for smaller, simple sites)
e At Search & Be Found, we use POWER theme

Are they the best themes? Possibly, but we don’t
know - since we've only used a few of the themes
(out of the hundreds available).

What you do not see below the surface of how it
looks and feels, is the way its built, how well thought
out the modules are and the level of documentation
and support. This is a differentiator when deciding
on a theme.

But are they excellent themes? Yes, we've used
them to build a ton of beautiful, fast, effective web
sites.

HubSpot Template Marketplace

Find everything your website needs

Note: if you're interested in meeting the
developer behind CLEAN theme, check out our
in-depth episodes (here and here) with Kevin
Fremon, the developer of CLEAN Theme.
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Core CMS Functionality

in Content Hub

As well as the themes, there’s also tons of modules
that you can add into any site (usually regardless of
the Theme you're using). For example, here’s a
module for adding a calculator (eg mortgage
calculator) to your site.

HubSpot Template Marketplace

Find everything your website needs

e — ==

The Best Website Modules
(Curiomiza thesa frse ond premitem emoiave: 0 1 vour weCeie vision. HubSpat mades ane designed by profestionds, 22
VR 00 0 o ivering your best work nd SelghTing Your cusTomers

128 0f 428 resits

Timeline with Scrolling Animation

100

Animated Statistics

There’s a range of price points (starting at Free)
for Themes and Modules. Whilst we've narrowed
down to just using a few specific paid themes and
modaules in our business and for our clients, we're
constantly surprised by how many high quality
free options there are. Plenty of free themes and
modules to get you quickly started on building

a website.

HubSpt

HubSpot Template Marketplace

Find everything your website needs

Build your next website foday!  HubSpor's free CHS foos indud o drog-and-drop website buikder.

The Best Website Themes and Templates

= e themes and temp

customizing your website.

1124 of 233 resuits

Sprocket Rocket Free

Atlas Free

One other really cool feature of HubSpot is that
you can have multiple Themes in your portal and
create pages from different themes (ie Home page
could be based on one Theme, and the About page
using another theme). This is a big advantage

over WordPress, where you can only have one
Theme active at a time (ie all pages are based

on one theme).
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Core CMS Functionality

in Content Hub

Child Themes

Child Themes are newer to HubSpot (available
approx mid 2021) and provide a beautiful layer
between the source Theme (which can be regularly
updated by the Theme developer) and your own
customisations of the theme (eg some specific
formatting/styling/functionality changes).

The first step in any new portal and website build is
to create a Child theme from the main theme and
make all your changes in the Child theme.

Practical, real world,
HubSpot advice for
growing your business

Your Weekly Shats of HubSpot
Strategy &Best Practice!

Popular Episodes

Child themes also mean you can create separate
versions in your portal if you have multiple websites.

For example, we host a number of websites in our
portal (including HubShots, XEN, XEN Create and
XEN Solar). We've purchased CLEAN Theme Pro
once in our portal and created Child themes for each
site. All the styling and branding for each site is
managed in each separate Child theme.

YOUR

Rapid Response P

Design Team I ~

>

#

T g

Wi "
| CRAIG BAILEY

How Does the 5-Stage Plan Work?

Getting design work
done can be really
frustrating if...

K o e s i
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Core CMS Functionality
in Content Hub

Content Types Site Tree
Most website CMS platforms allow you to manage The Site tree tool is a simple folder visualisation for all
the following content types: your pages. It's often missed - you can access it from
either the Landing Pages or the Website Pages listing:
* Web pages
* Blog posts
* Images Website pages ~
* Videos

+ Files (PDFs, docs, audio, etc)

By ‘manage’ the content we mean: You can filter what shows in the site tree:

* Host the content (ie upload or enter the
content or files)

« Version control the content (ie saved versions,
and ability to restore previous versions)

* Protect the content (ie permissions)

* Report on the content usage (ie analytics)

4 type is oy of Website pages o« Landing pages

Content types can also extend to:

* Emails

* Social posts
Knowledge base articles
e Ads

A few quick tips:

¢ You can view both Website pages and Landing
pages (but not blog posts)

* The Resolved Language is often the issue (if you
don’t see any pages) - you may need to change
the language to see pages (‘English - Australia’
to ‘English’)

Content Hub includes tools for supporting and
managing all of the above.

Feature we'd like to see: We'd love to be able to
save the Site Tree view, like you can with listing
page Views.
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Core CMS Functionality
in Content Hub

Drag and Drop Editor Sections (a collection of modules) can also be added:

Tools for building web pages should be easy to use
- via Drag and Drop approaches. File v Bty View's et Hilp Y
Today, this is table stakes for any website tool - so
of course HubSpot has this built in throughout the Add to page

product.
L Q

A huge range of modules come standard to be Modulos i

dragged onto a page (or email):
“ Saved (18/50)

Exit | File v Edit v View v Settings v Help ~

Add to page
k

Q get started

start
Sections Layouts get started
el

* Theme (58)

A i HubSpot
ao H 2
oo Website Design
Accordion Blog Post Breadcrumts Card Flipper o , =
Menu {Pra) Thumbnails... {Pra) Singhe -

dara cohrbnt Cohtbnt
Flippers Filter = Opt Filter - Opt Hero Section
(Pra) 1 2.
Smart
+ Show more
Generic Hero Image for XC

Y Text (6)

~ Commerce (3) Billing Details

- =

Payment

~ Design (4)

Divider Herizanta Tobbed cord Table of
SFOCQF Contents
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Core CMS Functionality

in Content Hub

Publishing Controls

Approvals

Requiring Approval for a content piece (Eg website
page, email, etc) to be published is a common
requirement in larger companies.

HubSpot provides a simple approval process whereby
content creators can prepare everything, and then
simply request an approval for it to be published.

Scheduled publish

Pages and posts can be scheduled to go live in the
future.

This applies to brand new pages, and also to changes
to an existing page ie you can prepare the changes for
the page (eg an important announcement, and save),
but not have the changes actually go live until the
required time.

Publishing options

~* Schedule publish Schedule unpublish

Schedule update

B 26/03/2024 @ 8:28 AM AEDT

Your website page will remain published and your new changes will
go live at 26 March 2024 8:28 AM (Australia/Sydney).

Update now

The process for scheduling blog_posts is similar.

You can also bulk publish.

Scheduled unpublish

Pages can be scheduled to unpublish at a future
date, and (bonus) can set the now unpublished URL
to automatically redirect to another page.

The automatic redirect means visitors won't see a
404 if they visit the original URL, and you won't lose
any of your Google juice for that page’s terms.

Publishing options

Schedule publish +' Schedule unpublish

Schedule unpublish

B 28/03/2024 W 12:00 AM AEDT

When page is unpublished, redirect visitors to *

https://www.hubshots.com/hubspot-campaign-start-t.. ¥

Your website page will be unpublished on 28 March 2024 12:00 AM
(Australia/Sydney).

Update now

This is something you would have to do manually on
other platforms but HubSpot has thought about! It's
the 1%.
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Version History

You can view a full version history of any page - by
hovering over the Save link in the top right corner of

any page:

Last saved 25/3/2024 8:31 AM

Your page is saved automatically
whenever changes are made.

Open version history.

Or from the View menu:

File ~ Edit v View Settings v H

Version history I

Page details

Preview URL

SEO Features

We have a whole section later covering all the SEO
features in more depth. The summary is that
HubSpot Content Hub provides all the standard SEO
features you'd expect:

HUBSPOT CONTENT HUB OVERVIEW GUIDE

From there you can open the version history:

¢ Bock

Version history

25/3/2024 B2 AH
Cusrem drah

1. 207372024 1:10 PM

Beautiful
Websites

Grow your brand wi
built in HubSpot

Publisted verion

20, 30/3/2024 107 PH

19, D0/3,/2004 1:02 PM

18, 20/5,/2024 101 PM

Eriko Diduro Get Started

17, 20,/3/2024 1:01 PH

Erifn Diguro

16, /3024 100 PM
Erika Didura

15, 15/3/2024 22 P
L4, B/3/2024 1035 PM
Eriin Didure

U3, B/3/2024 10:21 PM

Erika Diduro

12 W20 1:53 PM

11 T/3/2024 130 PM

Simply click on one of the saved revisions to load it.
Review and then if needed restore to that version.

e Page title and meta description

e Canonical URLs

» Featured images and social meta details

+ Redirects

+ XML Sitemaps

¢ Robots.txt

e Cross domain tracking

¢ Integration with Google tools (eg analytics,
search console, etc)

See page 36 for the full details.
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Managing
Content

Landing Pages versus Web Pages
versus Blog Posts

Currently Content Hub has four main types of page:

+ Landing pages

* Website pages

* Blog posts

* Knowledge base articles

Search HubSpot

88 workspaces :
Website Pages

2] CRM Landing Pages

< Marketing llele]

Conftent Knowledge Base

Customer Portal
3 Commerce
HubDB

Automations

SEO

ol Reporting & Data

Design Manager
3 Library

) CRM Development

@ Template Marketplace

They also have other access points eg

e Customer portal (to view Tickets)

* Membership pages (just a locked down version
of landing pages or website pages)

* Meeting scheduling pages (to book into your
calendar)

* System pages (eg login, password reset, etc)

In this guide we’re going to focus on the first three,
ie Landing pages, Website pages and Blog posts.
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Managing
Content

Landing Pages versus Web Pages

First though, let's understand the difference
between Landing Pages and Web Pages. This is a
common question from users - what's the
difference? Since they seem very similar.

Here’s the main differences:

+ Landing pages: don't get added to XML sitemap
by default, can be organised into Folders

* Website pages: do get added to XML sitemap
by default

Previously there used to be differences in the
reporting that surfaced (Landing pages had more
of a conversion process, and Web pages showed
better smart content comparisons, some video
stats, etc) but they are mostly aligned now. Any
remaining differences will likely be smoothed out in
the coming months.

Which brings us to the question of whether we
actually need two different types of pages.

And is it better to combine them?

Our Take: They should (and probably will)
combine Landing pages and Web pages
into Pages (and just use some options in
the publishing controls to manage any
other differences)

Eg simple checkbox for blocking from Google, and
simple option for whether to include in XML
sitemap or not.

And combine the best of the reporting tools.

Ideally you end up with just Pages and Posts (ie like
WordPress)

Historically having them separate made sense
because Landing pages were in Marketing Hub and
Website pages were only in CMS Hub. But with
Landing pages being taken out of Marketing Hub
and only available in Content Hub, it makes sense to
combine them IMO.

Note: We have no inside knowledge of whether
this will happen or not - it's just our opinion.
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Managing
Content

Blog Posts

Blog posts likely don’'t need too much explanation -
most people are aware of what a blog post is.

However, for clarity, let’s highlight a few key
differences between blog posts and standard web
pages:

+ Date is important - blog posts use date for
ordering on listing pages

* RSS feed format - blog posts have limits on the
formatting and layout of the content - they tend
to be a block of text with images/videos inserted
- often consumed on other reading devices/apps

e Tagging - blog posts are often tagged based on
topics or other categories

You can have multiple blogs in a HubSpot portal.
They can be for different domains, or you can also
have multiple blogs on a single domain.

Blog

Data Management

Properties Current view:  wwwhubshots.com

Objeets

Import & Export

Ganeral Ten ate Formats Commd

Audit Logs
= WWWXENCOMLOU

—_ wewcraighalley.com
acls
Blog name

- www XEnSClarcom.au

ety www.hubshots.com
- wwwhubshots.com
Caling Interral name used for argas
- wewwxendigitoleom | WWwhubshats.com
b Blog header

Marketing 5
HubShots Create new blog

Website

oTihe fop o1 51g X Import blog
v

Domains & URLs

Navigation menus Page title

HubShors | Aussie ‘Unofficial HubSpar Podcast

Australio’s 'Unofficial’ HubSpot Facussed Podcast, hosted by Tan Jacab and C
Bailey.
ied $or t vkt direrigetion hog i bleg Hliting pagis
Customer Portal
Blog root URL
Payments URL Redirects
A ir—s Use language siug in URL

Domain
ChatSpot

Preview Pages

Being able to send a preview link to people is really
handy.

Even though the page changes haven’t been
published yet (eg an upcoming time sensitive
announcement or launch) you can send a preview
link that shows all the changes.

This can also be handy for checking an upcoming
page change on different devices (eg on mobile) -
simply view the Preview link on your device.

This can be incorporated into Quality Control (QC)
processes as well eg asking testers or QC
colleagues to test the page before it is live.

The Preview link can be taken on any page, from the
View menu:

Version history

Page details
XEMN
Preview URL &

Or next to the Publish button in the top right:

Q #+ Settings

Again its the little things that make a difference.
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Managing
Content

Featured Images

You can easily set Featured images on pages and
posts - these are the images that will show when
sharing eg on social channels:

Featured image

Enable featured image >
Ehoage or upkead on image 10 b Lsed when sharing your page on social medic

Imoge alt test

HUBSPOT Content Hu Overview Guide | XEN Create

Collaboration (Comments, Tasks)

HubSpot has been rolling out simple collaboration
tools throughout the product over the past few
years.

The right hand floating menu bar provides tools for
comments, tasks and accessing the social calendar.
In our experience, the comments tools is the most
useful. Comments are a handy way to message
others in the team, highlighting areas to tweak,
review or answer questions about.

1 e Overvies Guits | XEN Erecte

Collaboration (Comments, Tasks)

HubSpot nas been rolling out simpie collabaration toals througnout the product over the past few
years

Theright u bar provides 100ls for comments, tasks-and acoessing the social
calendar

Inour experience. the comments toals is the most useful Comments are a handy way to message

milar to usage inother areas (eg

Adding comments is simple, and support for
@mention of users is similar to usage in other areas
(eg notes on objects).

> o Pcomments

Back ta all comments
@ oo

N @lon Jacob

Collaboration (Comments, Tasks)

HubSpot has been rolling out simple collaboration tools throughaut the product over the past fehv

Flosting meny bar provides tools for Comments, tasks and 30cessing the social

st ful.C
areas to tweak. review of ans

Menus (Navigation)

toalis touse
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Managing
Content

Menus (Navigation)

Building Menus might be a strange thing to highlight
in an overview guide, but from experience using a
ton of other CMS tools in the past it's worth
highlighting how easy the HubSpot tool is to use.

Strangely though, it is a little hidden away in the
Settings > Website > Navigation menus area, or via
the ‘More tools’ menu when on the Website pages.

Website poges = = k | crosee =

* 48 pogt - * a5 g * A8 gorehed * pecenypassnll  Advonced menus [P

Cantent stoging

Adding and managing menu items is easy:

Data Management
Navigation menu
Properries
Help your visitors find what theyre looking for with navigation menus. Manage
Objects: your menu links and labels here, then go 10 your tempiate o choose which menu 1o

Import & Export use in your content.

Tools
HubShots Header | 2024 - More »

Meetings
Calling T,
Inbox £ Newsletter

Marketing Clone

£ Podcast

website Discard changes

Domains & URLS i (e Delete

Navigation menus Shaw revisions

£ QuickCheck

Pages

£ Masterclass

HubShots | Masterclass | 1
Knowledge Base

Private Content T AOE meny rem

There are some nice touches, such as the ability to
see revisions of the menu (eg if you accidentally
delete a menu item you can easily get it back), as
well as being able to easily add URL parameters to a
menu link:

+ Add menu item

Add item without link

Add page link

Add page link with URL parameter

Add URL Link

Note: There is also a simpler menu tool
available within some page modules, but we
hardly ever use that
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Managing
Content

Using Files A few features to note (that are often overlooked):

* You can set expiration dates on files (they are
automatically sent to trash on that date - yes,
there is recycle bin to get them back if needed)

* You can set files to be blocked from Google (ie
noindex)

¢ You can update existing files (using the Replace
option at the bottom), especially great for
documents that have links to them

Who thought you could get excited about a File
Manager? Sounds boring we know.

But we have to highlight a few of the nice little
features in the HubSpot File tool.

You probably know you can easily create folders
and upload files (eg images, videos, PDFs, docs,
etc) into HubSpot via the Library > Files tool:

File details

midjaurney-insp

xen-create-midj inspiration-guide-vol005

&)

Images

~ Access and URLs

File URL visibility

Documents Public

File URL by domain
W NEnCreate.com

Audio

Open in a new window Copy URL

> File usage

Videos

All videos

Videos with advanced features -
~ File history

Activity
Reploce

You can move, delete, archive files as well as rename:

29 December 2023 4:43 PM
Wiew full file history

General

Thu, 28 Dec 2023 6:04 PM

@ xen-create-midjourney-inspiration-guide-vol..  Derails ACHONS ™ - noindex 2529 M8
Updated

Fri, 29 Dec 2023 4:43 PM

@ iourney-inspi Rename 3859 M8
File sive
14 M8

@ ney-insp; Move 39.69 MB

@ xen-create-midjourney-inspiration-guide-vol002 Invalid dimensions found

Mowve to trash

File type

pf

Fille I

151362588805
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The Replace option is particularly useful if you refer You can also see links to where a file has been used
to the file in multiple locations eg a file that can be (eg in pages or emails):
downloaded from multiple pages (or from emails).

You essentially update the existing ‘file’ by replacing File details
it with your new one. HubSpot does all the behind
the scenes stuff to ensure the new version is
available from the places you've referred to it form.
Very handy!

xen-b2b

As mentioned above you can also set whether the
files are indexed in Google or not (eg we set older
versions of files to be noindexed): Public -

Access and URLs

File URL visibility

File URL by domain

WWW.XEN.COM.aU ¥

v Access and URLs

Open in a new window (¢ Copy URL
File expiration dote @

File URL visibility

& DD/MM/YYYY

Public - noindex ~

File usage
~ ‘Website pages (2)

- XEN | Item | Annual Marketing Review (AMR) £
Public

XEN B2B | Resource Listing Page [

File history

Public - noindex

General

Private @
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Smart Content

Smart Content is one of those underused features in
HubSpot - it looks great in demos, but hardly
anyone uses it (there’s a reason why we don't cover
it until Stage 4 in the HubShots Framework)

Which is a shame. Because we all know how
important tailoring content to be as relevant as
possible is.

Smart Content is very powerful. Essentially you can
use a range of criteria to switch out content on web
pages (and emails), including:

¢ Location or Language (Eg show different content
based on the country of visitor or their language
preferences)

+ Device (ie show simpler layouts on mobile)

« Lifecycle stage (Eg for showing special offers to
customers)

+ Referral sources or UTM parameters (eg show
different messaging based on where the visitor
came from)

¢ Lists (the option for complete control)

Manage smart rules X

Manage content for specific visitors specified by the rules below. If @ visitor matches multiple
rules, they will see the content in the rule that comes first,

Show different centent based on &

Select category

Ad source

Contoct list membership

Contact lifecycle stage

Country

Device type
Referral source 3
Preferred language

Query parameter

Once you've selected the smart rule criteria you can
then set ‘rules’ for switching the content:

Manage smart rules

Manage content for specific visitors spacified by e ruies below. If @ visitor matches mulripie|

rules, they will 36 the content in the ruie that comes first,

Show different content based on @

Country

Rules

S united Kingdem

+ Add

Using Lists you can segment your visitors based on
just about anything.

With Lists you can segment based on any contact or
related object property.

Interested in trying it out - visit this page on the XEN
site and set your own properties, then visit the Home
page to see how the content changes based on your
selection.

Note: May take a minute or so for your settings
to propagate through.
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Personalisation

Contents see £ Content (Column 1)

You've probably seen personalisation tokens used in Magic Module (..

emails (eg tokens to insert ‘First name’ at the start of
email).

# Content

Smart rules @
With HubSpot you can also use personalisation + Add

tokens in web pages.

HubSpot uses cookies to track visitors on your site
and if it can recognise the person visiting it can Text
easily use personalisation tokens in the page (and

use fallback details (when unable to recognise the
ViSitOI’) know which content element is which in the list.

Content Element Name:

This is for organizational purposes only. So it's easy to

Text
Note: See the HubL section on page 28 for an
example of it in use on one of our sites. Select Content Element:

Rich Text

Rich Text

Heading3 ~ B I Y More-

2 Insert - Personalize Advanced -

Stay up-to-date with
HubSpot's Content Hub

(Smione)

Edit Personalization Token

< Back

Contact: First name

Default value @

Use this property’s global default
value

Apply Cancel

Apply changes
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Using Forms and Meetings in Pages

Adding Forms, Meetings and other interaction items
(eg CTASs) is simple in HubSpot.

They appear as modules that can easily be dragged
onto pages.

Alternatively, they all have the option to create an
embed code that can be inserted manually within

pages (and also externally in other systems if
required):

Add to page

15 form b4

Sections (1) Layouts (0)
el

>

v Other modules (12)

Form Wizcrd HubStrap
{Pro) Text & Form

HubStrap
Text & Form

Hub’&‘Srup
Text And
Form...

Landform - Landform -

Blockquote...

A
Site Search Symphony Vast Footer
Form Theme Form

Form . Contact...
Section..

Below is a meeting embed on our HubShots Quick
Check page that one you go through will ask you a
few questions and also give you the ability to invite
others to the meeting. Now you can also collect a
payment part of the meeting booking!

HubShats

Newsletter Podcast Framework QuickCheck Masterciass  Contact

Schedule a QuickCheck session
with Ian and Craig from HubShots
April 2024

Option 1:
Book your HubSpot
QuickCheck now

MON TUE WED THU FRI  SAT SUN

Just book a time that works for you and we'll see you then for
your HubSpot QuickCheck.

Not sure if you want to book in yet?

Not a problem, let us know how we can help
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Adding Video to Pages Saved Sections
You can add video to pages by: Saved sections are simply a way to save a set of
modules and styling that you have already created
¢ Hosting the video in HubSpot on a page.
+ Embedding from another video host (eg
YouTube, Wistia, etc) For example you might have a standard About Us

section on a page that includes text, imagery,
perhaps a form etc. Simply save as a Saved Section,
and then you can easily drop the entire section onto
other pages when editing them:

There's pros and cons to each.

If you're aiming to build an audience on YouTube (eg
like we are with our HubShots channel) then

embedding YouTube videos into your pages will be u
appropriate.

File v Edit v View Settings v Help

YouTube Overview

Exit
Add to page
k

Q

Modules Layouts

¥ Saved (18/50)

L4
. , . HubSpot .3
However, if you're keen to control the styling, and Website Design

keep people on your site, then hosting your videos in
HubSpot and adding to pages will be the way to go.

Hero Section
Or have a mix. S
Generic Hero Image for XC
HubSpot includes an integration with YouTube (as
part of the Social tools) to pull through basic video

stats. Billing Details

If you host the video on HubSpot you can enable
Advanced Video Features (per video) for detailed
analytics.
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Call To Action (CTAS) The main benefits of using CTAs (eg using a CTA
button versus a standard button):

CTAs are another underutilised feature in HubSpot.
« Central management (ie change it in one place

Most likely because they are a bad name (eg similar and the changes are reflected everywhere on the
to how people don’t know what CMS means). site that it is used)

* Reporting - easily see how many views and clicks
Almost two years ago we did an entire HubShots a CTA has had
episode on HubSpot CTA best practices, and most
of it still stands up today - check it out here (or The new CTA tool replaces the legacy CTA tool (but
watch the video here to see lan sporting an if you still have legacy CTAs they will continue to be
awesome moustache). supported).

The summary though: Reasons to keep legacy CTAs - here’s features we

loved (but aren’t yet in the new CTAs tool):
* CTAs are a way to guide your visitors to the

content that is relevant to them
¢ CTAs can be links, buttons, banners, pop-ups,
slide-ins

¢ Multi-variant testing CTAs (ie test variations of
the CTA to see which performs the best). Note:
this is not supported in the new CTAs tool at this
time.

Usein Al - « Smart CTAs allow you to tailor the content

(based on properties of the viewer). Note: this is

not supported in the new CTAs tool at this time

1

Embedded Embedded Image Embedded Button

~ Advanced options EZ0

&
Embedded HTML

Create ap TML CTA and
§ nes or
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Here's an example of a legacy CTA on the XEN site: We're hoping they add this functionality back into
the new CTAs soon.

Bonus: it highlights associated deal revenue as
well (based on people interacting with the CTA).

XEN | Talk to an Advisor | Direct CTA

Dote Ronge: © 01,01/2000 o © 29032028

Clicks ~

Reminder: check out the full HubShots episode
281 where we cover CTAs in detail.

Call-fo-action placements.

Revenue Atiribution

/100 TOTY30M  FILTERS @)

°
AU$1,248.20

This is for a legacy multivariate call to action button
on the Home page that tests four different wordings
on the button. The screenshot shows the results
over the past two years. Based on this we could tell
if particular wording resonates better with our
audience.
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Now we move on to some of the more advanced
tools. These tend to be used by more sophisticated
users, but are worth being aware of even if you are
new to HubSpot.

Content Staging

Content Staging allows you to prepare completely
new pages in a staging environment separate from
the live pages.

This provides three main benefits:
* No chance they accidentally turn up in Google
* No chance they are accidentally published by
another member of the team
¢ You don't disrupt your current website or work

Note: It's a little hidden away (you'll find it
under the More tools dropdown) and only
applies to website and landing pages (ie there’s
no concept of staging emails for example).

Website pages ¥

Advanced menus
# All pages ~ # All scheciulec * Recently published

Content staging

HubDB

Content Staging has separate areas for each domain
(if you have multiple domains in your portal), and
can access your current Themes

One thing we love about HubSpot’'s Content Staging
is that when you push a page live HubSpot does all
the updating of URLs automatically, as well as any
redirects needed. This might sound obvious, but if
you've used other systems you'll be aware that often
a part of go-live from a staging environment is
having to run a bunch of scripts to update staging
URL references in page content with the live URL
versions. Not needed with HubSpot, it does it all for
you.

Again it's the 1% that makes a massive difference
here in technical administration when it comes to
publishing pages from staging.
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A/B and Multivariate Testing When talking adaptive testing there are some items
that they suggest testing:

Testing page variations is easy using the built in

testing tools, available from the Lab section on the « CTAs
side of any page: * Copy
* Media

- Test * Layout

Run a test

E: Run A/B test

Create variaticns of your page and put them 1o the test. 8

Run adaptive test

MO sire what 1o test? Try these:

eTas copy Madio

]

D

e n
“Your page traffic wi Te: ive paged
# 50450 o e

A cali-o-oction (CTA) s @ buthon or ik that you place on
your welbsite to chive prospective customens 10 become leads
by filling cut @ form on a konding page. CTAS shouid be:

@ Eosy o spot. Use a.color that confrasts with the main
color scheme of the poge.

@ Action-oriented. Use verbs bhe “Dawnload” or
“Register” fhat compel vistors fo chck

@ oy to understand. Siate cxoctly wha the visirer wil
get If they chck an the CTA and g o the landing page.

Learn more about CTAs (5

The testing tools allow you to split traffic between
page variations and then either manually or
automatically choose the highest performer:

Note: Adaptive tests are not supported on

R [ e
Run a test X

Create variations of your page and put them to the test. &

A/B test Adaptive test

Your page traffic will Test up to five page
be split 50/50 variations. The one
between two page that performs best will
variations. You choose automatically be
the winner based on shown to visitors the
the test results. most often
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Using HubL in Pages

HubL is HubSpot's markup language that can be
used in pages and emails. It's not a full programming
language, but it does include the basics including
variables, functions, IF statements, operators and
loops.

Using HubL you can quickly build simple content
functionality.

Here's an example of a simple HubSpot page that
uses HubL to prepare a new tip each day. The code
is all contained in a single HubL resource file that
works out what day of the year it is and shows a
pre-prepared piece of content for that day.

Get OreanzeoVizand @)

OrganizeIn 5

Here's your daily 5 minute home organizing tip

04 Minutes, 14 Seconds

This is generated by HubL

Hi there,
Take off your chef’s hat.

cxaticingredients, have

And you're done!
Now you'l have some simpler options ready to go.

Remember:
1. Move fast. 2. Don't overthink, 3. Feel great about getting organized!

Check outthe latest on the blog

Here’s the code being called in the page editor:

GOW | CLEAN | Oi5 Daily Tip

Gontents » Multi-Column Conent

Multi-Column C...
/" Content

Smart rules &

+ Add O
1111/ Column 1 rg

Rich Text Editor: © Here's yo

HublL code

/

Hi there,

Hi| & First name |,

04 Mi

{{myGOWVariables.myGOWCurrentQuoteToUse}
} &1

{{myGOWSnippets.myGOWOffer}}

Take off your chef’s hat.
1. Gather your favorite cookbooks.

2. Consider the meals you usually prepal
3. Consider opting for dishes that take 19

Bonus tip: This same HubL works in emails
as well
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Using HubDB in Pages It's as easy as referencing the appropriate HubDB
table in your page settings:

HubDB is a simple, built-in database within HubSpot.
Think of it as a simple spreadsheet table tool within
HubSpot.

Seftings

Genesal

Featured imoge

HubDB is often used for keeping tables of people, Templte
assets, products, locations, etc. Anything that is
easy to store in a flat file format. Advonced

And then the best part - you can pull that data and
use it in HubSpot pages.

Managing the HubDB tables is easy:

Here's an example of a page where profiles are
generated and placed on a page by updating a
HubDB table:

Joanna Rowland

GOVERNMENT
TRANSFCRMI Speakers  Agends  DiscussionTables  Partners  FAQ  Magaine  AdvisoryBoard  Testimonial
summIT

HM Revenue
& Customs

View speakerprofile »

Audience access

Require o passwerd 1o view the poge

Advanced settings

Dynamic pages

Data source @
View dynamic pages source

- Speakers Summit v2
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Multiple Sites

HubSpot allows you to manage multiple sites in a
single portal. You can have multiple domains, and
multiple sub-domains of each domain as well.

For example, we manage the HubShots site in our
XEN portal, along with our XEN, XEN Create and XEN

Solar sites.

Each of these sites has their own domain setup, as
well as blog and landing pages. (Also email sending
domains.)

For companies managing more than one brand,
HubSpot is a compelling option in terms of
functionality. It especially shines when marketing
teams are keen to view attribution across the
brands.

Multiple Blogs

Further to the multiple site functionality above, each
site can have multiple blogs (if desired). As a simple
use case, clients have created separate blogs for a
single brand, with separate blogs for news, insights,
people. The benefit being they can easily pull from
separate blogs throughout the site (eg show latest
news posts at the end of a product page, and show
latest people posts at the end of an About page etc).

See our earlier section covering how to manage blog
content for additional details.

Membership tools (Private Content)

HubSpot has some basic membership functionality
built into pages.

Pages can be set to require a password or login in
order to access:

Access Control

Control whe has access to your landing page when i's published.
® Public

Anyone on the infernet can access this landing page

Password required

Set asingle password and share it with your audience. Visitars will need fo enter this password to

access the landing page

Registration required

Give specific contacts acces

access his landing poge

Members of your erganization who sign in with SSO et

Here is the access control that is available for blogs
including the option to only give entire access to full
blog posts to members:

Access Control

Conirol who has occess o your blog when it's published.

® Public

Give anyone access fo the entire blog but only members occess fo full posts [EEE

Access group membership required
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Integrating Al features is a big focus for every
platform company, with the aim of helping users
achieve more, quicker and easier.

HubSpot has been rolling out user facing Al features
since early last year, and the momentum continues.

Some Al tools are little more than glorified spell-
check tools, and some are just noise (eg Al blog
tools that produce low value guff at scale). But
others are truly useful.

We have an entire Al focussed episode coming out
soon, so we won't spend too much time on the
details here. Instead we’ll quickly summarise some
of the recent updates.

One thing they have done well is use it in specific
places like, example like generating page titles and
meta descriptions.

Alin Blog Posts

This is one of the noisy Al tools.

The tool allows you to generate a blog post from
start to finish:

e Get the Al to help you generate topics, titles,
targeted keywords, and more with a simple
prompt

¢ Refine and iterate on a blog outline before
receiving the final output

Whilst we think there’s some value in the ideation
pieces and even the outline and change tone
processes, overall this is just a junk machine. If it's
so easy to generate an article like this, who is
actually going to read it? Your audience is likely just
putting the same query into ChatGPT or Bing or
Claude themselves. Why would they bother coming
to your site to read the same guff? Plus Google is
weeding_out this low quality stuff from results
anyway.

- -
a

Tauvs
Rofrarring
+ You can set the version of your styla reference algorithm wi
« There are d options to chose from Expand
= ==5% 1 The original style reference algorithm we releal
Shorten
= ——4% 2 Tha one that was default up until taday

o ——5% 3 A new versian of 5¥] with better performance | Change fone 2

Bl -5V 4 A new varshon of sv2 that with imgroved performance (this is defauti e

L&1's take a look at some fesults:

PAGE 31


https://qz.com/google-search-ai-generated-content-spam-bots-1851310595
https://developers.google.com/search/blog/2023/02/google-search-and-ai-content

XEN CREATE |

HUBSPOT CONTENT HUB OVERVIEW GUIDE

Al Features

Al Post Narration

This is one of the useful tools.

Let's say you've taken the time to actually create a
decent piece of content.

Now it's time to repurpose the content into other
formats. That's where Al tools can really offer value.
The post narration tool uses Al to turn your blog
post into an audio version. You have control over
the Al voice that is used, and whilst there’s still little
giveaways that it's Al, the overall output is
reasonably listenable.

Post narration

Review the Al-generated narration before publishing your blog post. You can
also adjust the transeript, change the voice and generate again,

Marration transcript

Welcome 1o HubShots Episode 306: HubSpot View tips, Copying
Contact properties to Deals, Saved Sections, Associated Objects

This edition we dive into:

Did you start fast in 20247

& HubShots Framework version is available

How to build a simple Marketing View of Contacts
How to build a simple Sales View of Contacts

How to efficiently copy up contact properties to a deal
How to use Saved Sections in HubSpot pages

How to view Merged Tickets

Midjourney vé prompt for adding text

Strategy versus Tactics

Using Associated Objects in Lists

AT Voice

Select a hyper-realistic Al voice to narrate your blog post.

Onyx

Marration preview Remove

P 000 /953

Quick test: ask any Al narration tool to say
‘marketing lead magnet’ and listen for it
pronouncing ‘led magnet’ instead of

‘leed magnet'.

Want to see it in action? We've started adding this
into the latest episodes of HubShots on the
episodes posts.

Allmage Generator

If you've seen our Midjourney Inspiration Guide (free
download, version 5 now available) you'll know how
focussed we’ve been over the last 12 months on the
ability to generate incredible images using Al. Our
tag line has been ‘never use a stock image again’.

However, having to switch out to Midjourney to
generate the images adds friction to the process.
We're looking forward to being able to generate
images easily in HubSpot.

To date the results from HubSpot’'s image generator
(eg via ChatSpot) haven’t been anywhere near the
quality we're generating with Midjourney, but it will
be interesting to see if that gap closes in the coming
quarters.

For content creators who just need quick featured
images for blog posts, the Al Image tools in HubSpot
are a lot better than using stock libraries.
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Al Translations

We've been impressed with how good tools have
been getting at transcribing meetings into words
lately. The accuracy has shot up in just the past few
months.

We are hoping the same improvements in accuracy
come with translation of those words into other
languages.

To date, any time we've wanted to provide
translated content we've had to use manual
translation services because we don’t trust the
automated translations tools... but it's getting much
better.

As a quick test jump onto a foreign language site
and use Google translate to translate it into your
native language - sometimes it's so good you’'d

never know it was originally in another language.

We're excited that this same level of experience will
soon be available in HubSpot.

We'd love to provide our HubShots episode show
notes in other languages. And combined with Al
narration, we could potentially offer an audio version
as well.

We're on the cusp of a shift in efficiency here.

Al Ads Assistant

Whilst not part of the website content focus, it's
worth mentioning that HubSpot is pushing out Al
tools across the entire hub suite. For example, Ads,
Social and other areas are also getting Al assistants.
We'll be covering all of these areas in a separate
episode.

Initial tests of this has been promising if you focus
on testing different ad copy and just not having a
block when it comes to writing ads.

AI assistant now available for ads

Save time by using the HubSpot Al-powered assistant to generate quality ad copy and
headlines in seconds.

¥ Generate the body copy of your ad

Describe what your od is about®

¥ AI Assistant

AI assistant is currently available for:
+ Ad sequences
+ Engagement ads
» Lead generation ads
« Website visit ads
+ Search ads

Please avoid sharing any sensitive information in your prompts. To improve the product, HubSpot logs and
stores your prompts, generated language, and usage metrics when you use Al confent assistant. For content
moderation purposes, HubSpot shares your prompts with OpenAl, and your prompts will be attributcble 1o
you. By using the AL content assistant in beta, you agree te comply with HubSpat's Beta Terms &7 as well as
OpenAl's Usage Policies ! and Sharing & Publication Pelicy &
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There’s a bunch of new features rolling out that are

exclusive to Content Hub (ie they won't appear for Our Take: We're looking forward to using the
existing CMS Hub customers). Content Remix tool heavily. We spend a lot of
time creating the source content for our
episodes, but then drop the ball when it comes
to repurposing and reusing the content. (As do
many marketers!). We are hopeful a tool like
this will allow us to get our content (which we

) feel is high value) across other channels in
For now, the content below is pretty much taken other formats easily.

from HubSpot's overview presentations to us:

We're just starting to play with these tools now, and
will update this section once we have more details
and the overall user experience.

Content Remix Podcast Hosting

We don’t currently think of HubSpot as a place to
host our HubShots episodes (we currently use
Soundcloud), but we'll be interested to see what
benefits HubSpot provides. We’'d love to be able to
see how many downloads an episode gets (currently
it's really hard to get download stats from Spotify,
Soundcloud and Apple podcasts).

Repurpose your content for multiple channels and
formats in just a few clicks

e Quickly generate landing pages, ads, social
posts, audio, images, and more to reach
customers

e Expand into podcasting and social channels by

making content creation easy and manageable
Combined with the Blog Post Al Narration feature

(discussed earlier) we could see this being a very
streamlined process for getting content out quickly
in multiple formats.

Test_Remix flow #

Plus if it gave us better reporting and stats this
could be a great win.
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Content Library

Think of this as an advanced version of Files, but
with the ability to manage private access to
contacts. This is the start of HubSpot's move into
wider content management (ie think digital asset
management).

Content Embed

The ability to make sections of your HubSpot
content available for embedding in other systems
(eg WordPress).

This could potentially also allow embedded content
to use smart content and thus personalise the
experience even when hosted in other platforms.

Note: You can potentially do a version of this
currently using Smart CTAs - and embedding
on another platform.
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We touched on SEO functionality at the start -
mentioning it was a requirement of all website
systems these days.

Let’s dive into a little more about some of the tools -
both good and bad.

Page Recommendations

In the left hand side of each page you can see a list
of specific recommendations for the page, covering
all the key SEO areas.

Recommendations

You're writing about the topic:

hubspot content hub

Subtopic Keyword:

hubspot content hub guide *

Topics

Title

@ Add a page title

The title appears in search results, and
helps search engines know what your
page is about.

Learn more about titles [

Unique title and domain name
Repeating the domain name in your title
makes this content lock less trustworthy to
search engines.

Title length

A title that's less than 70 characters is less
likely to get cut off in search results. Your
page title is 47 characters.

Meta Description

Images

This is so handy, and very easy to action.

We recommend checking this everytime you go to
publish a page.

Page Title and Description

The Settings section (on any page) provides full
control over page title, meta description and URL

Settings

General Page name

Featured image
Internal page name * ©

Termpate
P! XEN Create | HubSpot Content Hub Overview Guide | LP
Language *

Audience access Pagetitie* ©

Advanced

Page URL

Page URL
‘www.xencreate.com/hubspot-confent-hub-overview-guide # Copy link
Meta description © +

Understand the full potential of HubSpot's latest release, Content Hub, using this
comprehensive guide. Explore key website fools and more.

@ Greart Youre within the imir. 16 choracters remaining

‘Add to marketing campaign

Note: Anytime you see a little diamond at the
top right of a box, that means you can use Al to
generate the text (eg generate the page title or
meta description).
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As well as featured image settings, canonical URLs
and language settings (eg for localization):

Settings

Featured image

Enable featured image

4

Audience gocess

Advonced

Image it text

HubSpot Content Hub Overview Guide | XEN Create

Seftings

Canonical URL
Tempiae
Customize cononicol URL &

Tedl pearch engines which URL should be prefermed i The coment in sis
poge i vailabis somewhere el on your sie.

Lenguage
AUBNOE Q0TS

Advanoed

You can also set custom HTML in the header and
footer of the page:

Settings

General Additional code snippets
Featured image Head HTML &
Tempiate =
Language

Audience access

Advanced

Footer HTML &

A common example is adding in code to noindex
a page.

XML Sitemap

Managing the XML sitemap for your domain(s) is
easy using the XML Sitemap tool, available from
Setting > Website > Domain & URLSs:

Select your domain and you can see all of the pages
and posts in your sitemap:

Domains & URLs

Domains URL Redirects Language Setfings svom sst

Objects Pages to include in your sitemap

Data Management

Properties

Import & Export

o manage how your HubSp is shown Here's alist of pages included

sitemap XML fle.
Audit Logs P

Tools
Meefings
PAGE

Calling

Inbox ~ + Add @ page

‘Website @ 1Growth
bt
I Domains & URLs I

Themes

101: The HubSpot Cleanse

Blog

Pages
Episode 103; E
itps:/ /s

HubSpot Content Topics Cluster Tool, HubSpot CRM Saved Filters, Link B

Knowledge Base

Private Content

Episode 106: Reflecting on 2017, Rich Results, Ranking for position #0
hitps://wvadubet 106

Customer Portal

You can use the Search box to find specific pages
and Remove as needed (eg we like to remove all
Thank you pages from the sitemaps):

Domains & URLs

View XML file &7 X ‘

TYPE

Website Page
Website Page

Options. ite Page

Remawve

Website Page
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SEO Tools

robots.txt

HubSpot gives you full control over your robots.txt
file from your Settings > Website > Pages

By default you can set how the robots.txt file is set
for all domains:

e listing pages

et oach biog lsing poge's coronic

®) Donr nod canosicol

However, as needed you can optionally manage per
site, using the ‘Override default settings’ toggle:

Data Management Pages

Choose o domain to edit its setfings:

wwse hubhate.com =

500 & Crowlers

Tempiates Branding Personalization Integrations

Robots,fxt

Custeenin

Override def

Redirects

Managing redirects is extremely important for both
Google and for user experience.

The redirect tool in HubSpot is easy to use, available
from Settings > Websites > Redirect:

‘Website

Domains & URLs

You can manually add redirects, either individually
or using flexible rules:

Add URL redirect

Redirect Type
@ standard
Flexible

Original URL *
Redirect to *

~ Mare opticns
Redirect style
®) Permanent (301) 0
Ternparary (302) @

Provcy @

Priarity B

B Assign the lowest pricrity &

Also, when scheduling an Unpublish from a page,
you can set the unpublished page URL to redirect to
another page (avoid 404s) - see section earlier.
That Unpublish process will automatically create an
entry here in the Redirects section.

Another 1% that makes a big difference.
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SEO Tools

Cross-domain tracking

Setting up cross-domain tracking is simple in HubSpot. You simply turn it on from Settings > Tracking &
Analytics > Tracking Code

settings

t Add desnain

four Freferences
Autematic cross-domain linking
oy links on your sifes b0 enakbie link-rocking between domains

Gl

Notifications

LEmit tracking 1o thets domasns

Azzount Dufoudns

Limit cookies fo subdemains

Vibers & Teoms Lirrsir = bi reaCking ockio 10 e Subasrain plasng i AL cpoesed 1o 1
The sourpes jool And rod yourcompany.Com

Irsegrations v

Harketpoce Downloods Use secure coakies anly

iy e MubSpat's tracking cockie % with @ secure connection. This will orly work on poges using MTTPS
Trocking & Anchytics e Gy 5P i) COCKE Cn poge a L=t orly work on poges wsing

Tracking Coda

Bat filtaring

Once enabled, HubSpot adds a parameter to the URLs to allow tracking a visitor's journey across your
different sites.

Connecting with Goog|e Analytics Connecting Google Search Console is managed via
the Integrations settings:

Adding in Google Analytics or Google Tag Manager
is simple, via the Settings. If you have multiple sites,
you can set each individually.

Connected apps

Integnations

| Cornectod Apps

Pages

Chosse & domain 1o edit its settings:

I Befoult settings for all domains - I

VIR cting for o single domain, choase

Tempiares aranding peontedl Trpegrations | 08 o

These intogrations wil anly 11ck users who have aped in 1o Glow cookies f yaur HubSpot cookie bantsr i set o equire opt-in, Learn mer

Tracking integrations You can add the Google Search Console from the
e m—— App Marketplace (it's free).

;u Google Search Console

[¥] Integrate with Google Tog Manoger @

Enter your Google Tag Manager 1D

GTM-Wm m

TG e —— Once added you can then connect your Google

: account and select the properties to integrate. The
Google Search Console data is used in other tools
through the portal (see next page for example).
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SEO Tools

SEO Tool (Scan, Analyze and
Keyword/Topics)

We have mixed feelings about the inbuilt SEO tool in
HubSpot.

Parts of it are useful (eg the Analyze tab), but other
parts (especially the Recommendations section) are
misleading and unhelpful (in my opinion).

Analyze tab
First, the useful part - the Analyze tab.
As long as you have connected Google Search

Console into HubSpot (see previous section), HubSpot
will pull in impression, click and position data:

Ton maes 8 YOTAL peeeassion o

17,101 215%

ABLSE LI TR B

1,098 794,163

This is handy for quickly seeing which content is
driving traffic, without having to log separately into

Google Search Console. You can drill into each of the

pages for further analysis.

Recommendations tab
Now, onto the misleading...

The problem with the Recommendations tab is that
when users are confronted with so many
recommendations they either:

* Panic, call us, and worry that their site is a disaster,
OR
« Ignore everything, because it all seems too hard...

A big part of the problem is that HubSpot has
‘outsourced’ a lot of the analysis to Google Lighthouse,
which is predominantly a developer tool. This returns a
ton of stuff that seems scary and important but in
reality is often impossible to fix anyway (eg imagine a
marketer seeing that they need to ‘Reduce the size of
page network requests’)...

s stylesheets, load
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SEO Tools

Instead, we usually recommend users reduce their
filtering to only show the items that are meaningful
and actionable. This will reduce the list shown (but
won't update the totals at the top unfortunately).

Here's the way we filter down recommendations:

¢ Impact: just Medium and High (ie hide the Low
impact items)

¢ Technical difficulty: Low and Medium (ie hide the
High technical difficulty items)

* Role: Marketer (ie hide the Developer items)

This will make the item list much more useful and
actionable for marketers:

Add image alt text attribute

Fixing links is a key item to action, as is things like
making sure images aren’t huge (a common problem
- we'll often find that users have uploaded a 20MB
icon for a small design effect), although thankfully
HubSpot is good at optimising images automatically
anyway.

Summary of the above: often useless and
concerning, but there are some helpful items there if
you know how to filter it down.

Topics tab

This isn't as bad, but is less useful than you might
think. The aim of the tool was good - give users a
way to research keywords and then plan out their
content strategy using a hub and spoke model.

But the reality is that hardly anyone knows how to
do this, and if they do they are probably already
using a much better, fully featured tool.

That aside, there’s still some value with researching
keywords and getting a relative sense of the search
volume, and then associating terms with content on
your site(s).

SSL by default

It hardly needs mentioning these days, since it's
default for most platforms, but yes, HubSpot adds
SSL to all websites by default.
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The following section overlaps with marketing
activities, and aren’t specifically about website
management.

However, the overlap is a key feature of building
your site in HubSpot - not only are you building and
managing the content in HubSpot, but you're also
managing the promotion of the site and seeing the
results in one place.

We see this as a significant value add of building in
HubSpot, compared to building your website(s) in
other tools and having to switch between them to
perform basic analysis.

Brand Kits

Brand kits are a way to organise default Logos,
URLs, Favicons, Colours and Themes for a brand.

Setting up a brand kit helps keep consistency in
place across pages and emails, as well as pre-filling
some of the colour picker tools.

Whilst still reasonably simplistic, they are a good
initial step in guiding a brand’s colours and logo on
assets.

For portals with multiple sites the Brand Kit option is

a little clunky, and tends to work best when using

business units. But this won’t cover scenarios where
a single business unit has a micro site with different

branding to its main site.

HUBSPOT CONTENT HUB OVERVIEW GUIDE

But hey, it's a start. The main reason we set these
up in portals is:

* The default colours in the colour picker

» Easy toinsert Logos in the right size with the
right ALT text (eg when using the logo modules
in page headers and footer sections)

Connecting Social channels

We love the Social tool in HubSpot. The main reason
is for the reporting it provides across your social
channels.

You can also manage and schedule all your social
updates (which we also use) but this isn’t the main
benefit (see later section on Reporting) since there’'s
tons of tools that can manage social scheduling
well. We wouldn’t say that HubSpot's social
managing tools are best in class (compared to some
of the dedicated enterprise social management
platforms out there), but it is very simple to use, and
did we mention reporting?

Handy Tip: you can add social channels and
then set permissions for who can access each
one:
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Considerations

Connecting Advertising accounts On the flip side, once connected you can also push
audiences (eg contact audiences, retargeting, etc)

Another biggy for reporting - even if you don't back up to the platforms from HubSpot. Such a time

manage your ad campaigns within HubSpot (we saver.
don’t for example) we still recommend every
customer to connect their ad accounts into

HubSpot for the reporting and attribution benefits. Connecting Goog|e’ LinkedIn
and Meta Pixels

The ad accounts can easily be connected
from Setting:

Once your advertising accounts have been
connected in, you can then easily insert pixels from
each of the ad platforms into HubSpot automatically.

There’s no limit to the number of accounts you can
connect, and you can easily connect multiple
accounts (eg if you have multiple brands and sites in
your portal).

Note: we usually don't insert pixels via
HubSpot, instead we prefer to insert them via
Google Tag Manager.

You can also pull in Lead form submissions from the
platforms so they automatically create contacts in
HubSpot (ie no more needing to export CSV files
from the platforms and import via an upload). This is
such a handy feature:

Marketing
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Cookie Consent Tools

HubSpot has a comprehensive cookie consent tool
built right in.

You can build individual cookie consent popups for
each specific domain, including for separate
locations, and tailor the user experience, including
look and feel.

Available from Settings > Privacy & Consent

Settings Data Privacy & Consent

Consent Opions analyze

Data Privacy
Your Preferences

General

Notifications Intreducing Coekie Seanning [0

Tools like this are easily missed, or under
appreciated. We've audited portals for clients and
discovered they've used a completely separate (and
expensive) 3rd party cookie management tool, when
they could have just used HubSpot’s inbuilt tool.

Sometimes we think HubSpot could make more
money by unbundling these tools and making them
also available as simple standalone products - it's
bizarre when we hear clients complain about the
cost of one of HubSpot's Hubs but then find out they
are spending more than the HubSpot cost just on a
3rd party cookie management tool...

You can new scan and block ol cookies on your website,

Account Setup

Account Defaults

Users & Teams
Integrations ~
Morketplace Cowrioads Manage cookie consent for your HubSpot domains
Trocking & Analyties v

Data privacy kws require websites fo get visitor consent before using cookie fracking. For each domain below, you can add and design

a consent banner, Consent banners can help you follow applicable laws and regulations. Learn mare.

Tracking Code
Attribution

DOMATN MAME

Tracking URLS

| Privacy & Consent

Sandboxes

Security

Approvals =3

Partners v

Data Management
Properties

‘Objects

Import & Export

Audit Logs

CONSENT BANNERS » COOKIE BLOCKING MONTHLY SCAN SCAM STATUS

& Active @ Disabled ® Active Complate

Inoctive ® Disobled

Inactive #® Disabled

Inactive #® Disabled Disabled

Inactive @ Disabled

7 MNext 3 Last ¥
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Considerations

Campaigns

What are Campaigns?

Overview

stsstons o HEW CONTACTS (FIRST ToUGH) O

In marketing a ‘campaign’ could be: s N
Revenue Attibution
e An overall marketing initiative
« A specific campaign in Google Ads, or Facebook
etc

n ° s ASSOCIATED DEALVALE ©
AU$885.73 AU$15,726.00

« A specific ebook that is being promoted etc
e Etc

New contacts =

In HubSpot, the ‘Campaign’ tool is a way to
consolidate all the assets and activities related to a
certain goal (eg a new product launch).

The Campaign tool allows you to create a ‘campaign’
which is essentially an umbrella of all the landing
pages, web pages, emails, social posts, ad P e
campaigns, blog posts, CTAs and other marketing
assets related to that goal.

> Blog posts (85)

> Landing pages (1)

After creating a campaign and associating the
relevant assets you can start analysing the results
of the campaign.

> Website pages (55)

> Workflows (1)

We've covered this topic in more detail in episode
278 of HubShots, and you can also our download
our complete guide to Building_a Campaign in
HubSpot from Start to Finish.
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Reporting
Tools

One of the areas that HubSpot shines is with its
reporting tools. Not only are there a ton of out-of- s vrs rmeror otr 1
the-box reports for website engagement, but there’s
also a full custom report builder that can report
across web activities.

And further, because the website is fully integrated Revenue Attibation
with all the CRM tools, you get to see the full end-
to-end customer journey across your content assets
(ie how they first come to your website right through
to the revenue they generate through deals).

ArTazBuTes nevenst @ 1ouTes Revese © ASSOCIATED DAL VALUE ©
AU$1,800.00 AU$3,000.00

Page metrics
sounce rare
69.23%
v 20

Performance Tab on Pages

Before we even get to the overall reporting options,
it’s worth highlighting the reporting you can get at a
page level.

Every page (landing page, web page and blog post)

PR saGE iEw

e
31 seconds
2 e

has a Performance tab that highlights:

¢ Overall page metrics (views, form submissions,
contacts, customers etc)

* Page metric trends over time

« Source channels (organic, social, paid etc)

e Revenue (both actual and influenced)

These performance tab metrics are our
recommended first stop when wanting to quickly
see the results of a recent promotion.
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Tools

Built in Content Reports

Now onto the higher level analytics.

Out of the box HubSpot provides traffic reporting,
which can be presented over timeranges and broken
down into segments (Eg source, location, devices,
pages, etc):

This report allows you to hover over bar graphs to
see further details, as well as drill into each area to
see specific results (eg the actual contacts that
came from a specific channel).

This level of reporting is crucial for marketing
managers to determine what’s working at a high
level.

Customers often ask us which is better: HubSpot
analytics OR Google analytics

Our answer is always: Use both. Google Analytics will
have far more flexibility to dig into specific events on
the site, but has a huge blindspot: it can't tell you who
the specific contact is that converted. You'll see
conversion totals (eg 6 conversions) but won't be
able to see which specific contacts they are.
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This is a key differentiator with HubSpot analytics -
the level of contact level detail you can drill down to
(out of the box) is incredible (IMO).

We challenge anyone to get this level of contact
level insight using WordPress + Google Analytics.

Custom Reports

But it doesn’t stop there. Custom reports allow you
to build very specific reports by joining across not
only the pages and web activities, but joining it with
actual contact data.

HubSpot Custom Reports are often overwhelming to
new users (back in the day we banged our head
against a wall for the first week or so of trying to
make them work) but once you have the basics

understood the Custom Reporting tool is your
special friend.

Bonus: once you've built out the custom reports
you need, you can add them to a dashboard and
schedule it to automatically send to the
management team every Monday morning.
Thanks HubSpot!
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Reporting
Tools

Al Assistant Report Builder

Review your report

And ﬁna”y, we finish on a less happy note. Here are your Al-generated report details. Look
over what we've identified, correct anything

that's wrong, and click 'Show Report’ to see the

The industry quip ‘Al is just everything that isn't i

. ) . You asked:
Worklng properly yet Sadly hOIdS true In some how many contacts did we get from social
HubSpOt Imp|ementatl0ns. media channels this year so far

Data source

The Al Assistant Report Builder is one such example.

Contact interactions

It's pretty lame so far. But we can see where it is Group By

going... date range

For hs_contact_create_date
This entire year

User story: We all want the ability to easily ask .,
leasure
questions of our data using natural language. f Count of Contact Interactions

Filters

But solving this is hard. Google has been trying to A
provide this for years (if you've ever used the query INTEGRATION, PAID_SEARCH, or
engine in Google Analytics you’ll know the pain

we're talking about) and the results are lacklustre at
best. You still need someone who is experienced
with the tools in order to get the insights you're

after. Start overs

FALEe

This criteria couldn't be found. It may have
been deleted

So too with HubSpot's first attempts.

Rate this report

© @ &~

For starters it only supports Single Object reports.
OK, no problem with that - we need to start with the

basics. But even then the results are mixed. Often Those grumbles out of the way, we're quietly
simple queries (eg ‘show me contacts from social confident this area is going to improve rapidly in the
media channels this year so far’) return incorrect coming year.

query criteria and incomplete results.
For now though, you still need to invest your time
learning the manual reporting tools in HubSpot.

Interested in getting started with the Custom Report
Builder in HubSpot? Check out these beginner
videos (here, here and here) on our YouTube
channel.
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Developer
Features

HubSpot has a ton of developer features, but we
don’t feel qualified to cover them - since we don’t
use them ourselves (we're not developers
anymore...).

This is a shame because from our limited exposure,
the developer tooling seems mature and
comprehensive - we wish we were more familiar
with it (but we already stretch ourselves too thin).

Some of the key features include:

e Fully exposed API
* Private Apps
GitHub integration
e CLI connection

If we ever need custom modules for use on a
website we chat with Kevin at Helpful Hero (the
developer of CLEAN theme) and he builds the
custom module for us. We've done this a number of
times.

If we ever need complex development done (Eg
custom integrations or custom functionality) we’ll
usually chat with our friends at Modern Visual or
Brand Chemistry who have teams in place for this.
Let them know we sent you!
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Gaps

Whilst Content Hub includes a plethora of website
and content tools, no product is ever complete.

That's why there’s such a vibrant discussion area on
the community forums. Aside: will be interesting to
see if HubSpot adds Content Hub as one of the
areas in the community Discussions dropdown.

With that said, here’s a few of the key gaps we've
encountered that we’d love to see plugged:

Adding Instagram

We get this question on almost every website
project.

Adding an Instagram feed to a HubSpot website isn't
possible out of the box, and there’s no module in the
Marketplace for adding it.

Instead you'll need to use a third party service to
capture your feed(s) and then embed them onto
your site.

We've written a whole guide on how we add
Instagram for clients using Curator.io (a third party
tool).

To be fair, this isn't really HubSpot's fault, because
Instagram controls how their API can be called - it
requires a server process in the middle (which
HubSpot doesn’t support). This is different to
WordPress based sites where a WordPress plugin
has the ability to run server processes on the
WordPress hosting server.

Accessibility features

Accessibility requirements (ie design considerations
so that people with disabilities can use the site
without barriers) are important for most website
projects.

Content Hub doesn’t have any in-built functionality
for ensuring compliance, and understandably so.
The requirements vary based on location (eg
country/state) as well as industry, Government
versus small business, etc.

Which means you'll need to use an outside tool or
platform for managing your accessbility
requirements. There's a number available, but at
XEN we use accessiBe (more details here).
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Gaps

Blocking Pages from Google Additionally it would be nice if having a setting like
this could automatically control whether a page is

Blocking pages from Google is a little tedious in added to the XML sitemap (ie if set to noindex, then

HubSpot. Currently you have to manually add a automatically remove from XML sitemap).

noindex tag in the Head HTML:

<meta name="robots" content="noindex">

Settings

Additional code snippets
General

Featured image Head HTML @

Template

Language

Audience access

| Advanced

Would like to see inbuilt options for marking as
noindex, similar to how you can do this in WordPress
via Rank Math:

Rank Math X

§33 = Advanced e

ROBOTS META
|:| Index |:| No Index

D Nofollow |:] No Archive
|:| No Image Index |:| No Snippet
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HubSpot Content

Hub Tiers

All this functionality is well and good, but what tier do you have to purchase to get it?

HubSpot is keeping the Starter, Professional and Enterprise tier approach for Content Hub. They are also
introducing the Per Seat model that they’ve recently rolled out in other Hubs. Whilst we're still drilling into
the specifics of each tier, here's a few quick features of each:

Content Hub Starter

A no brainer way to start, with:

* Website pages, landing pages, blog posts

« Al tools for generating topics, blogs and images

¢ Use full Themes from the Marketplace

+ Basic website analytics

e Basic SEO tools

« Note: Starter is limited to 30 pages (across
landing pages and website pages) - whereas
previously this was 50 website pages with CMS
Hub

« Start with a single seat

Content Hub Pro

Pro becomes an option when you want to access
some of the advanced and new features:

¢ Content Remix

¢ Content Embeds

* Smart content

¢ Full SEO tools

« A/B testing

e Custom reporting

+ Memberships (note: this used to be an
Enterprise tier feature!)

+ Content Staging

e Starts with 3 seats

We suspect Pro will likely be the go-to tier for most
website projects that we do for clients.

Content Hub Enterprise

Enterprise is an option when:

¢ You need multiple sites
Approval functionality

¢ Advanced permission functionality
Starts with 5 seats

Marketing+ Pro and Enterprise

Along with the launch of Content Hub, HubSpot is
also offering a new bundle: Marketing+ (ie ‘marketing
plus’)

It's essentially Marketing Hub plus Content Hub, but
only at the Pro and Enterprise tiers (ie there’s no
Marketing+ Starter).

The advantage of this new bundle is:

¢ Compelling discount for buying both
* Marketing teams have access to all the marketing
and website tools (the ‘all in one’ promise)

We're a little wary of the new bundle because it
confuses the already complex pricing matrix on
HubSpot's site, but overall we really like it - it will
more often than not be what we recommend to any
companies who are initially only considering
Marketing Hub.
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Final Thoughts

We've covered a lot in this guide, but we feel like
we've only scratched the surface - there’s so much
more to unpack (plenty more coming in future
episodes).

But with all that covered, the question is: who is this
for? Or perhaps more importantly, who isn't it for?

Who is Content Hub For?

Our thinking on this will likely change as the year
progresses, but at this point we feel there are
segments within the two main audiences:

« Existing HubSpot customers: Highlight the ability
to extend their marketing management more
effectively across to include websites

* New HubSpot customers: introduce HubSpot as
a credible all-in-one marketing and website
option

Let’s think through each in turn:

Existing Customers

For existing HubSpot customers (specifically
Marketing Hub customers), the big opportunity we
see is for better tracking across all marketing
activities by bringing their website management into
HubSpot as well (ie moving from another platform
such as WordPress, Sitecore, etc).

Over the years we’ve had countless conversations
with marketing managers who use HubSpot but are
then surprised to learn that HubSpot has a website
option. And even when we show them how all our
own sites are on HubSpot they don’t really take it
seriously. It's not a technical capability issue, it's an
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awareness issue. Marketing managers just don’t
know about HubSpot's website capabilities.

WordPress mindshare - people now understand that
you can build just about anything on WordPress
(‘just find a developer’). But HubSpot doesn’t yet
have that same mindshare (‘can you really do this
on HubSpot?’). This will change over the coming
years as more sites are showcased, but for now we
get it - and we’re not expecting the mainstream
understanding of HubSpot’'s website capabilities to
change quickly. But we'll see.

This is a big opportunity. At XEN we've created an
entire separate brand - XEN Create - to help
customers focus on building websites on HubSpot,
and managing all their visual design assets within
HubSpot. We think it's going to be a big boost in
effectiveness for our customers.

New Customers
What about companies not yet using HubSpot at all?

The market is crowded with website content
management options (eg G2 lists at least 370
options and even more in the website builder
category) and even though HubSpot is one of the
highest rated, it still lacks mindshare in many
marketing manager’s minds. Interestingly HubSpot
CMS doesn’t even appear in Gartner’s list of web
content management companies.

With the launch of Content Hub, HubSpot is
attempting to break this barrier and highlight how
website management is an integrated extension of
all marketing activities and not something that
needs to be kept separate from the main marketing
platforms.
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Which means...

Content Hub is a launch to interrupt the market and
highlight the benefits of an integrated system to an
audience of marketers, who either didn't realise they
could do it in their portal already, or didn’t know
there was a platform on the market that provided
such an integrated and seamless experience.

We're excited to see where this goes in the coming
months in terms of market response.

Comparing Content Hub
with WordPress

A discussion of website options wouldn't be
complete without at least acknowledging WordPress
as a key ‘competitor’.

So, how does it compare?

The first comment we’ll make is that choice of
platform often succeeds or fails based on the
resources you have available. It doesn’t matter how
good the platform is if you don’t have a team to
implement it properly.

We've seen tons of excellent WordPress projects
succeed due to an excellent team in place.
Conversely we've also seen terrible
implementations, with slow, bloated, chaotic
installations that then fall out of Google and don't
generate leads.

The platform isn’t the issue. The people are.

HUBSPOT CONTENT HUB OVERVIEW GUIDE

Likewise we’ve also seen terrible HubSpot
implementations. And to be completely upfront,
we're always checking our own sites, optimising
them as we find issues, new features are released,
and old sections are tested and found to be not
working.

With that said, is HubSpot a ‘better’ platform than
WordPress?

Assuming you have access to excellent teams for
both WordPress and HubSpot, which would you
build on?

When to switch to HubSpot

Here's where we’d easily switch:

« Building beautiful marketing and sales focussed
sites

¢ For small, medium and large businesses

« That benefit from having an integrated suite of
tools across all marketing activities
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When NOT to migrate from
WordPress to HubSpot

At XEN we've built hundreds of WordPress sites
over the years (we started building sites around
2008), but a few years ago we stopped all
WordPress development and switched everything
over to building websites on HubSpot. Our own
XEN site used to be on WordPress, as did the
HubShots site - we've moved them over in the last
few years.

So, we're big fans of using HubSpot for websites.

However, there's a bunch of sites we still host on
WordPress, and will likely never move off
WordPress.

Why?

The main reasons for staying on WordPress (for
us) include:

* No easy way to migrate over comments (some
of our sites have 1000s of comments we don’t
want to lose)

* No easy way to move ecommerce related
processes from WooCommerce over to Shopify
(and then be able to use HubSpot for the main
site)

* The site has tons of legacy content and
functionality where the cost of migrating it over
doesn’t match the ROI

That's just a few thoughts to consider - and your
business’s specific circumstances will need to be
understood fully to put the above into
consideration.

Summary: moving from WordPress to HubSpot is a
decision based on: resources you have available,
legacy functionality and content, ROl expectations,
and future requirements.
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YOUR RAPID RESPONSE
DESIGN TEAM

WHAT XEN CREATE

CANDO FORYOU

Graphic Design

Elevate your brand with stunning visuals that communicate
your message and resonate with your audience.

e Social media graphics e Brand style guides e Icons

e Facebook ads e Powerpoint templates ¢ Business cards

e Google display ads e Slide decks ¢ Trade show stand designs

e Linkedln ads e eBooks e Merchandise design

e HubSpot campaign e Brochures e Canva templates

e Email signature banners ¢ Flyers and posters e Zoom background designs

e HubSpot email template ¢ Reports ¢ Midjourney photo generation
e Blogimages ¢ Infographics e Simple photo retouching

e Logos e 2D illustrations e And more!

Video Editing

Engage your audience with captivating video and animation that tells your story and
delivers your message effectively.

¢ Shorts (TikTok, YouTube, e Podcast production ¢ Product demo videos
reels, stories) e Explainer videos e Testimonial videos

e Social media posts and ads e Tutorials e GlIFs

e Company profile videos e Commercials e And more!

¢ Presentation videos

Websites

Grow your brand with a professional website built in HubSpot.

e HubSpot website design e HubSpot blog page design
e HubSpot one-pager e HubSpot quote templates
e HubSpot landing page design
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WHAT'S DIFFERENT
ABOUT XEN CREATE

Speak to
your designer

Skip the hassle of tickets and
messages by jumping on a call with
your designer or video editor.

Rapid response

Say goodbye to delayed task queues
for quick fixes; enjoy rapid updates
from your designer.

Plan all your
outcomes at once

Experience seamless brand
consistency with us as we efficiently
plan multiple items, eliminating wait
times between tasks.

Never use a stock
image again

Upgrade to exclusive Al-created
imagery from tools like Midjourney
and Adobe Firefly, with full
ownership rights.

Graphic design for
HubSpot customers

We can set up all your visual assets
directly in your portal, including
landing pages, emails, social updates,
website pages, documents, files, etc.

Check out the Pricing page
on our website for more information.

VISIT WEBSITE

A,
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